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Upgrade Complexity 

 From version 8.1B: Easy � 

Enhancements and revisions in Adagio JobCost 8.1

New Features 

♦ Fully compatible with Windows 7.  

♦ A table for GL details for posted transactions 
Detail in the Job Inquiry to show the GL deta

♦ Installs the AdagioPDF printer driver. All reports and printouts from Adagio can be pr
document in the data folder. 

♦ Supports the features in Adagio ePrint. When ePrint is installed you can p
by the Report Type (General, Transaction or A
Date, System Date, Time). Click the ePrint button (red "EP" icon) on any report dialog to print the report to PDF. 
Reports option forces all reports to be printed to PDF. Reports can be printed to PDF and attached to an email (MAPI) with a single 
button click. 

♦ Report Favorites allow saving Reports with specific options chosen. Click the Favorite button (a star icon) on any report dia
create a Favorite. Favorites for a report can be accessed from the report dialog in a drop
Public Favorites are blue. Added Favorite Reports and Print/Delete Favorites functions to the Reports menu. Multiple favorites can 
be defined for the same report. Favorites can be private to the Adagio user or public for use by all users.

♦ Report Sets allow the grouping of Report Favorites into a single print job that will run unattended
printer or PDF files. Report Sets may be launched from a command file
parameter /R followed by the Report Set (ex. /RMonthEnd
each, the destination folder, filename and conflict strategy. 
set. Use Report Sets to automate the printing of all your 

♦ Added User Preferences under the File menu. 
options previously found under File | Options, Reports | Report Options and the C
'Alphabetically sorted field list' and 'Exclude Ranges'
printed. If no individual user preferences have been set up for a user, 
Administrator, user SYS, will be used. 

♦ You can now specify a desktop background color, image and/or text constant to display on the Adagio desktop. Use this feature
display your company logo. Use the text strings to make the company name prominent on the desktop. Any JPG or other graphic 
image can be centered or stretched to fit on the main program desktop. These settings are made on the 
Preferences function. 

♦ The option 'Auto-advance smart finder' has been added (in the User Preferences function). It controls whether the focus is on the 
previously found grid or on the search criteria field when the smart finder is opened. Select the option if you want focus to
next row in the grid, allowing you to press F6, Enter and march through the found list. Turn it off if you usually want to search b
new criteria each time the smart finder is invoked. In either case the position is advanced in the grid 

♦ The option 'Alphabetically sorted field list' has been added (in the User Preferences function). Turn this option on if you w
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date compatibility information is on the Product Compatibility Info

Adagio 
BankRec 8.0A – 8.1D 
Crystal Reports® 8.5-B for Adagio 
DataCare 8.1A - 9.0A 
ePrint 9.0A 
GridView 8.0A – 9.0E 
Inventory 8.0B – 8.1D 
Invoices 8.0A – 9.0B 
Lanpak 9.0D 
Ledger 8.0A – 9.0D 

 
ODBC 9.0A 
Payables 8.0A 
Purchase Orders for Adagio 8.1A
Receivables 8.0A
 

Other Products 
MS Office 2003, 2007
MS Windows XP

Enhancements and revisions in Adagio JobCost 8.1C (2012.05.13) 

A table for GL details for posted transactions is written to when batches are posted. This allows the drill down to 
GL details. New postings after installing 8.1C are required. 

Installs the AdagioPDF printer driver. All reports and printouts from Adagio can be printed to the AdagioPDF printer to create a PDF 

the features in Adagio ePrint. When ePrint is installed you can print reports to PDF files in configurable folders determined 
by the Report Type (General, Transaction or Audit). Fields can be embedded to establish the file and folder names (User, Session 

Click the ePrint button (red "EP" icon) on any report dialog to print the report to PDF. 
nted to PDF. Reports can be printed to PDF and attached to an email (MAPI) with a single 

Report Favorites allow saving Reports with specific options chosen. Click the Favorite button (a star icon) on any report dia
vorites for a report can be accessed from the report dialog in a drop-down field. Private Favorites are yellow, 

Favorite Reports and Print/Delete Favorites functions to the Reports menu. Multiple favorites can 
r the same report. Favorites can be private to the Adagio user or public for use by all users. 

Report Sets allow the grouping of Report Favorites into a single print job that will run unattended. Report Sets may be printed to 
may be launched from a command file or a scheduled Windows task by running tbwin

/R followed by the Report Set (ex. /RMonthEnd). A progress dialog lists the reports in the Report Set, the printing status of 
each, the destination folder, filename and conflict strategy. A log is generated that records the printing status of each report in the 

inting of all your daily or month end reports. 

Added User Preferences under the File menu. It allows you to set certain options by user that were previously global, including 
options previously found under File | Options, Reports | Report Options and the Company Profile. Includes new options 'On Start
'Alphabetically sorted field list' and 'Exclude Ranges'. The preferences can optionally be set for all users and preferences can be 
printed. If no individual user preferences have been set up for a user, all preferences originally set for the Adagio System 

You can now specify a desktop background color, image and/or text constant to display on the Adagio desktop. Use this feature
text strings to make the company name prominent on the desktop. Any JPG or other graphic 

image can be centered or stretched to fit on the main program desktop. These settings are made on the Appearance tab in the User 

advance smart finder' has been added (in the User Preferences function). It controls whether the focus is on the 
previously found grid or on the search criteria field when the smart finder is opened. Select the option if you want focus to

ow in the grid, allowing you to press F6, Enter and march through the found list. Turn it off if you usually want to search b
new criteria each time the smart finder is invoked. In either case the position is advanced in the grid each time the finder is

The option 'Alphabetically sorted field list' has been added (in the User Preferences function). Turn this option on if you w
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 – 8.1D 
Purchase Orders for Adagio 8.1A, 8.1B 

8.0A – 9.0C 

Office 2003, 2007, 2010 
MS Windows XP, Vista, 7 

down to the Transaction 

inted to the AdagioPDF printer to create a PDF 

rint reports to PDF files in configurable folders determined 
Fields can be embedded to establish the file and folder names (User, Session 

Click the ePrint button (red "EP" icon) on any report dialog to print the report to PDF. The Paperless 
nted to PDF. Reports can be printed to PDF and attached to an email (MAPI) with a single 

Report Favorites allow saving Reports with specific options chosen. Click the Favorite button (a star icon) on any report dialog to 
down field. Private Favorites are yellow, 

Favorite Reports and Print/Delete Favorites functions to the Reports menu. Multiple favorites can 
 

. Report Sets may be printed to 
or a scheduled Windows task by running tbwin.exe with the 

). A progress dialog lists the reports in the Report Set, the printing status of 
A log is generated that records the printing status of each report in the 

It allows you to set certain options by user that were previously global, including 
ompany Profile. Includes new options 'On Start-up', 

The preferences can optionally be set for all users and preferences can be 
all preferences originally set for the Adagio System 

You can now specify a desktop background color, image and/or text constant to display on the Adagio desktop. Use this feature to 
text strings to make the company name prominent on the desktop. Any JPG or other graphic 

Appearance tab in the User 

advance smart finder' has been added (in the User Preferences function). It controls whether the focus is on the 
previously found grid or on the search criteria field when the smart finder is opened. Select the option if you want focus to be on the 

ow in the grid, allowing you to press F6, Enter and march through the found list. Turn it off if you usually want to search by a 
each time the finder is opened. 

The option 'Alphabetically sorted field list' has been added (in the User Preferences function). Turn this option on if you want field 
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lists in the Column Editor and Filters fields sorted alphabetically. 

♦ Column Editor settings are now saved by grid by user by database. 

♦ Added an Excel Direct button to various grids, including View Customer and the customer transaction tab, Jobs, Phases, Categories, 
Estimates and Managers. Use the 'Enable SF Export' option in Edit User to enable or disable the Excel Direct button. Excel Direct 
from grids now has a progress bar and cancel for grids with a very large number of rows. 

♦ New program icon and toolbar buttons provide a cleaner look and differentiate this new version visually. If you are installing an 
upgrade to 8.1C, to see the new icon you will need to edit the properties of any existing JobCost shortcuts, click the Change Icon 
button and select the new image. 

♦ Added Job, Estimate and Archived Job Styles and Filters to grids and finders in JobCost. 

♦ Account Styles were added in Ledger 9.0D. They are now supported in GL account finder grids in JobCost. 

♦ Customer Styles and Filters in Receivables 9.0B and higher are supported in customer grids and finders in JobCost. 

♦ Added a Find button to the Edit Jobs and Archived Jobs functions to allow you to look up jobs by Job Description 1 or Contract 
Number, rather than having to determine job numbers or search by smart finder. 

♦ The Estimates finder and smart finder use a composite of the Estimates and Job Master tables. This allows you to search by Job 
fields when entering batches or editing Estimates. This means you can now search by Customer and do not need to memorize which 
jobs belong to which customers. 

♦ All report dialogs have been changed to the Adagio standard. 

♦ Added 'Report Preview Options' in the File | Workstation Options function to allow you to set the default preview zoom factor 
(percentage) and preview window state (full screen or partial screen) for previewing reports to screen. These settings are saved by 
workstation. 

♦ On the Open database dialog you can now use Alt-B to open the browse and Alt-F (for Favorites) to open the previously opened list. 
In previous versions you had to use the mouse to select the folder buttons. 

♦ Alt-X now selects the Excel Direct button on grids where it is available. In previous versions you had to use the mouse to select Excel 
Direct. Alt-F4 closes the program. 

♦ The vitalEsafe upload progress dialog has been improved and the progress bar now accurately shows the percentage. It is no longer 
necessary to install the vitalEsafe patch. 

♦ The Adagio menu now includes the module from which it was selected to allow you to quickly open another instance of the same 
module. 

♦ Most Access Violation (AV) errors are now recorded by module in an exception log text file. The file is located in the program folder: 
\softrak\ajwin\ajwin.error.log. An AV error is a generic error that can occur in Windows applications. This occurs when a program tries 
to access memory that cannot be addressed, which can happen for many reasons, including software or hardware/network 
problems. The address, program (EXE or DLL), form, and version information contained in the log will assist Softrak in tracing a 
problem if the address is located in the Adagio application code. 

♦ The System Status function can create a snapshot of detailed information about your Adagio installation and package it in a single 
zip file that can be sent to Softrak Technical Support or your Adagio dealer to assist them when answering questions or tracing 
problems. The information includes: Adagio install logs, program INI files and logs, system INI files and logs, directory listings of 
Adagio folders, versions and dates of all Adagio programs and system files. To create the snapshot zip file, select System Status in 
the Help menu, proceed when prompted and click the System Snapshot button at the top left of the Status of System screen. The zip 
file will be in the \softrak\system folder, located on the drive where Adagio is installed. The filename contains a date and time stamp, 
and is of the form AdagioSnapshotYYYYMMDD_HHMM.zip. The zip does not take any of your Adagio database files. 

♦ The Help | About screen has been changed to the Adagio standard, having a 'System Info' tab and including a link to a 
documentation page for the module that shows New Features, What's New video and manuals. 

♦ When JobCost is opened after installing an upgrade, a dialog is displayed with a link to a short video highlighting the new features. 
The dialog is displayed for each user until they tick 'Don't show this message again'. The video also be viewed anytime by visiting the 
Softrak website. Note: the dialog also appears when Adagio is installed at a new site. 

♦ The Adagio Data Source (ADS) writes to log files containing “last access” information about each workstation using Adagio, including 
the date, time, Adagio User ID, Windows User ID, Windows version and system settings. There is one log file per workstation, with a 
filename of <computer name>.log, containing one entry per Windows user who used Adagio. The log files are kept in the StationLogs 
subfolder, on the EZTasks path, typically \softrak\system\stationlogs. The log files are included in the System Status snapshot zip 
file. 
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♦ The Shade Color for reports found in the Report Options tab in User Preferences now uses the full color pallet rather than just 8 solid 
colors. 

♦ Grids, filters, and finders now show the lookup values instead of the raw data values for many typed fields. For example in Job grids 
the Revenue Recognition Method shows 'Completed Contract' and '% Complete' instead of 1 and 2. 

♦ Added Notes tables to the Crystal table (AJW81) to allow you to create custom reports in Crystal Reports for Adagio. Added Notes 
Header, Notes Detail, and History Notes Header and History Notes Detail. 

♦ The Edit/View Customer functions now show documents from history in Adagio Invoices 9.0A and higher on the Transactions tab. 

Install Changes and Fixes 

♦ This version moves toward our goal of a more Windows 7 friendly environment for installation. If you are installing to a mapped 
network drive that is normally accessible, but you cannot see it during the install when attempting to select a drive or folder, you can 
now install by browsing to the correct folder using the Universal Naming Convention (UNC), for example \\myserver\accounting\. This 
avoids having to adjust the User Account Control settings, which requires you to restart your computer and temporarily grant 
Administrative privileges to the user if they are not an administrator. 

♦ This version simplifies installation by removing any consideration of the location of the Report Tables Drive (RTD) by the install and 
program in virtually all cases. Therefore the install no longer prompts for the RTD. 

♦ The install writes to the master install log file "AdagioMasterInstall.log" in the \softrak\system folder. An entry is written to this log 
when any full, upgrade or SP for any Adagio module (with a release date of March 2011 or later) is installed. It shows the version 
installed and the version being replaced, the name of the Windows user who did the install and the rights for that user. An entry is 
also written to the log when an updated version of the Adagio Data Source (ADS) is installed, showing the version installed and the 
version being replaced. This log can be used to quickly determine the install history for all Adagio programs. 

♦ When you select the 'Backup Files' option during an install, the replaced files are now saved in a subfolder named YYYYMMDD in 
the BACKUP folder, under the programs destination folder (rather than the BACKUP folder itself, where extensions need to be 
changed to .001, .002, etc. when there are multiple versions of the same file). 

♦ The install includes an option allowing you to skip creating entries under Windows Start for cases where you will be manually 
creating an icon for the user to start Adagio and do not want them starting from Windows Start. During the install, uncheck the option 
'Start Menu programs'. This avoids having to delete or change the Windows Start entry that would have been created. 

♦ The install no longer checks the Opportunistic Locking setting (Oplocks) on the workstation. 

♦ The Opportunistic Locking setting (Oplocks) on the workstation is no longer checked when the program is started. 

♦ The System Status function in the Help menu (chksys.exe) no longer prompts you to disable Oplocks. It displays the current Oplocks 
setting and allows you to change it. The 'Check R/W Status', 'Check Specific Folder' function now supports UNC browse, whereas 
before you would have had to turn UAC off to use it. 

♦ SetServerForAdagio and SetReportsTablesDrive utilities have been updated. The latter should virtually never be needed at an 
Adagio site once any Adagio module dated March 2011 or later has been installed. 

♦ The install warns you if it finds reports in ModRP or CustomRP that may need to be adjusted for compatibility after installing a 
JobCost upgrade. See the section Converting Custom Reports and Views in the Release Notes for more information. 

♦ When installing Adagio JobCost (or other Adagio modules that use version 8.5 of the Crystal Reports print engine) for use with 
Remote Desktop Services (known as Terminal Services in Windows Server 2008 and previous versions), this necessitated manually 
copying the crystal folder from the main windows folder to the windows under each user. For example, on Server 2003 you had to 
copy the crystal folder from C:\windows\ to C:\Documents and Settings\username\windows. This is no longer required. The install 
and workstation installs will do the copy. The JobCost program will also do the copy if possible, which will avoid the need to do a 
workstation install in some cases. If the copy was not done you received an error when printing reports. 

Problems Fixed 

♦ The Data Integrity Check no longer reports errors in posting journals containing Jobs that have been closed and deleted. 

♦ Imported Job Estimates now show on the Job Estimates Audit report. 

♦ The Cost Types inquiry was disabled unless your Security Group was set to allow edit as well. 

♦ The Edit Notes button is now available on the Customer Inquiry function if the user belongs to a Security Group that does not allow 
access to Edit Customer. 

Enhancements and revisions in earlier versions of Adagio JobCost 

♦ Refer to the Readme help file for details of enhancements and revisions in earlier versions or Historical Enhancements under 
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Products on Softrak's web site. 

Installing 

To install Adagio JobCost you need the serial number and install code from the download instructions email sent to you by Softrak 
Systems. 

If you are installing an upgrade, you need the serial number and install code from the upgrade download instruction email. A previous 
version of Adagio JobCost should already be installed on your computer before installing the upgrade. If a previous version is not 
already installed, you can still install the upgrade. After entering the upgrade serial number and install code, you will also have to enter 
the serial number and install code from a previous version. 

Read the section ‘Upgrading to this Version’ below before installing an upgrade. 

If you are installing a Service Pack you do not need to enter a serial number or install code. However, a previous version of Adagio 
JobCost 8.1C must be installed before the Service Pack can be installed. 

To install Adagio JobCost (or an upgrade), run the program file you downloaded. Once the install program is running you can click the 
View button for detailed instructions in the Readme help. If Adagio JobCost is installed on a network, you must also do a workstation 
install for each workstation running Adagio JobCost. Refer to the manual or “Installing on a network” in the Readme help for 
instructions. 

To install the Adagio JobCost Service Pack, run the Service Pack program and follow the instructions on the screen. After installing the 
Service Pack, and depending on the version you were running prior to installing it, a workstation install may be required at each station 
running Adagio JobCost. To determine if a workstation install is required, start Adagio JobCost at the station. The workstation install will 
be automatically started if required. Note: If you are updating multiple applications at the same time, it may be faster to run the all 
workstation install to update all applications at once on the station. Refer to “Installing on a Network” in the Readme for instructions. 

Adagio JobCost 8.1C requires Adagio Lanpak (if used) to be version 9.0D or higher. 

Upgrading to this Version Upgrade Complexity From version 8.1B: Easy � 

Adagio JobCost 8.1C requires Adagio Lanpak to be version 9.0D or higher. Do not install this upgrade before you have installed 
Lanpak 9.0D if you require multiple users in Adagio JobCost. If you have any prior version Lanpaks installed but no 9.0D Lanpaks 
the Adagio JobCost install will warn you. 

A database conversion is required. You can convert your database at any time. You should perform a Data Integrity Check in your 
current version before installing the new version and converting your database. Any errors should be rebuilt or dealt with in your current 
version to ensure a successful conversion. You should make a backup of your database before converting. 

Version 8.1C uses new program icons. To see the new icon you will need to edit the properties of any existing JobCost shortcuts, click 
the Change Icon button and select the new image. 

GridView views originally created for JobCost 8.1B or earlier should be adjusted to use the 'Adagio JobCost 8.1C' dictionary (@J81C) to 
ensure that the information displayed is correct. Views used with GridView-RW MUST use current dictionaries to avoid the 
possibility of data corruption. 

Refer to the section 'Upgrading to 8.1C – converting custom reports and views' below for further details. 

If you have Adagio ePrint, the message "Do you want to turn on Allow PDF printing for this dataset, and enable PDF Printing for all 
users?" will be displayed the first time you open a database. Answer Yes to save having to manually enable PDF Printing for each user 
in the User Preferences function. 

Upgrading to 8.1C from versions earlier than 8.1B 

The Previously Opened database list is now saved by Adagio User rather than for all users. The first time an existing user or a new user 
logs into Adagio JobCost 8.1B they will be asked “Would you like your historical company access list set up?” Answer yes to have 
JobCost add all entries from the Previously Opened list from your prior version. It is no longer possible for all users to share the same 
Previously Opened list. 

Upgrading to 8.1C – converting custom reports and views 

Reports 

If you have modified any of the standard reports installed by Adagio JobCost, you may have to redo those modifications for JobCost 
8.1C. Modified reports are files with an .rpt extension that you copied from \softrak\ajwin\StandardRP to \softrak\ajwin\ModRP and 
modified using Crystal Reports for Adagio. If the report you modified has changed in this release from the version you modified, the 
report should be recreated. 



Adagio JobCost 8.1C     5 of 5 
JC20120513     12-May-2012 

Custom reports created in Crystal Reports for Adagio for earlier versions of JobCost may need to be modified or recreated for use with 
JobCost 8.1C databases. Custom reports are files with an .rpt extension that you placed in softrak\ajwin\CustomRP. If the custom report 
includes any table that has been converted in the database from the previous version of JobCost you were using the report may need to 
be modified or recreated. The main Crystal table for 8.1C is ‘AJW81’ and prior versions used the same table. 

Views 

GridView views originally created for JobCost 8.1B or earlier should be adjusted to use the 'Adagio JobCost 8.1C' dictionary (@J81C) to 
ensure that the information displayed is correct. Views used with GridView-RW MUST use current dictionaries to avoid the 
possibility of data corruption. GridView 9.0A (2008.11.06) or higher has the ability to convert existing views when the dictionary 
changes with the release of an upgrade version of an Adagio module. 

GridView view files are located in the folder \softrak\ajwin\views if they are launched from the Inquires menu in JobCost but may also be 
located in other folders. 

The structure of the Job Master and Job History (Archived Jobs) files were changed for 8.1C to support Find by Job Description 1. 
Fields were added to the Job Master, Estimates and Job History tables for Styles and Filters. J/C Job G/L Details and J/C History Job 
G/L Details tables were added. These new tables contain GL distribution details for posted job transactions. New postings are required 
before there will be transactions in these tables. 

The GETEXTERNALDATA function added in GridView 9.0C (2010.10.01) allows you to create composite views without using tables 
from the composite dictionaries, such as 'Adagio {Composite Tables 9.0A}' (@Z90A), which are no longer required or maintained. Any 
views using JobCost tables from the composite dictionaries should be updated to use the new function instead. 

-- end -- 


